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Logistic Regression Learning Goals

1. Be able to explain the usefulness of a logistic regression model
2. Be able to explain the fundamental concepts of logistic regression
3. Given LR parameters be able to
a. construct the LOGIT, ODDS and Probabilities
b. interpret the parameters of a LR model using the signs of the parameters and the unit and range
odds ratios

. Be able to use JMP to construct and use a logistic regression model for classification

. Be able to evaluate the predictive performance of a LR model using the misclassification rate, RMSE/MAD

and the Confusion Matrix
. Be able to apply variable selection (stepwise) for a LR model

. Be able to explain to a manager the insights from a LR model using the profiler
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e Whatis it?
e What can it do¢ (use cases)
« How does it work?
« JIMP Mechanics
e Interpret results (statistically)
e Interpret results (application)
« How to apply the results
« How to understand the managerial
implications
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WHAT IS IT?




response variable (Y) with continuous or categorical predictor
variables (X).

Y X Objective Predictive Statistical Model Fit
Accuracy Significance
Measure

Categorical Continuous  Prediction or  Misclassification  Prob > Chi- RMSE, MAD,

or Classification  Rate Square ROC Curve
Categorical (p-value)

All performance in Predictive Analytics is based on the validation set and not the training set

Developed by Jim Grayson, PhD
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WHAT CAN IT DO< (USE CASES)




e — e —
————

| ,,mong other modelmg tools, can be used

tennis match, based on other events ’rha’r have ’rronspwed?
Here are some other example uses of logistic regression:

|dentify fraudulent checks submitted to a bank

Determine causes of defective items in an assembly line
Predict flight delays

Understand reasons behind flight risk for employees
Determine which content to display on a website based on
mouse clicks

DRAFT Chapter 5: Logistic Regression from Building Better Models using JMP by Grayson, Gardner and Stephens (SAS Press).
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HOW DOES IT WORK?
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HOW DOES IT WORK?

A
(Yes) 11— .
We want to classify a tumor as
Malignantg O: Benign
1: Malignant
(No) 0

— >

Tumor Size

Based on anillustration given by Andrew Ng, Stanford University
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HOW DOES IT WORK?

A
(Yes) 1
Mongnonof;a ____________________________ Try Regression
(NO) O -1 No Yes
e —— >
Tumor Size

Based on anillustration given by Andrew Ng, Stanford University
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HOW DOES IT WORK?

(Yes) 1

Malignantl: - oo . .
But Regression Doesn’t Work Well Now

With Added Point
(No) 0 ——

Tumor Size

Based on anillustration given by Andrew Ng, Stanford University
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LOW DOES T WORK?

(Yes) 1

Malignantl -------- oo

(No) 0 —— We need a curve (function) more like this S shape

S — >

Tumor Size

Based on anillustration given by Andrew Ng, Stanford University
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HOW DOES IT WORK?

The coefficients are not fit using least squares, but a method called
maximum likelihood.

The basic idea is to try to fit coefficients so that the for the training data
the response (classification) prediction is as close as possible to the
observed classification.
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Al’rh@ugh we could use (non-linear) least squares to fit the model

(4.4), the more general method of maximum likelihood is preferred, ...

In other words, we try to find 8, and $, such that plugging

these estimates info the model for p(X), given in (4.2), yields a number
close to one for all individuals who defaulted, and a number close to
zero for all individuals who did not. This intuition can be formalized
using a mathematical equation called a likelihood function:”

Source: An Introduction to Statistical Learning, James, et al (Springer), p. 132-3.
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Simple Logistic Regression




jmp.comflearn rev 02/2014

Simple Logistic Regression
Logistic regression is used to predict the probability of the occurrence of an event.

o . ] . Example: Car Poll jmp (Help > Sample Data)
Logistic Regressidn Using Fit Y by X
[ FEY by - Contestual - IMP . |
- Digtribiion of ¥ for each X Modelng types determing analysis
From an open IMP data table, sefect Analyze > Fit Y by X.

Select Columns Cast Selected Columrs indo Roles Action
Click on a categorical variable from Select Columns, and click :Ef_‘fm_q e . Responge) | = 528 | O

Y, Response {nominal variables have red bars, ordinal :J:_m
W DUINETY

variables have green bars). : iz dage | Remeve
Lbype:

Click on a continuous variable, and click X, Factor (continuous | Recat
. . Lgisticc
variables have blue triangles). P |_ |_ Alack [ Help
I;.nq- -

Click OK to run the analysis.

| Cancal

Misight
Bivariate | Oneway =

e F'\'E'C.

| Cor Poll - Fit ¥ by 3 of size by age - IMP |-= &=

2 = Logistic Fit of size By age
By o &

i
By default, JMP will provide the following results: |._ n
Logslic | Contingency i ! L
The logistic plot, with curves of cumulative predicted - = 5 o4 oo |l

size

+ Medium
L < Smal

(fitted) probabilities.

i .If.1e:I|.|rn
The whole model test for model significance. |
Large
Parameter estimates for the fitted model. '
ane

Whole Model Test
4 Parameter Estimates

Term Estimate Std Error ChiSquare Prob=ChiSq

IMercepiLags]  -3.3826993 0ROT3TIA Aoz <000

ImerceptMedium]  -1.3265949 05753103 53z Dozie

ane 004987718 00164198 733 DO0EE

r
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Simple Logistic Regression

Logistic regression is used to predict the probability of the occurrence of an event.

Tips:

*  When the response is nominal, a nominal logistic model will
be fit. When the response is ordinal, as in this example, an
ordinal logistic model will be fit.

To color points and add a legend, right-click in the graph and
select Row Legend. Select a variable under Mark by Column,
and select Markers to change the marker, and click OK.

* To save the probability formula or request other options, click on the top red triangle and select the option.

* To find the fitted probability for a given value of X, select the cross-hair tool {] from the toolbar or use the
keyboard shortcut (C), and click on the graph.
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Simple Logistic Regression

Logistic regression is used to predict the probability of the occurrence of an event.

Interpretation (for this example, X = buying age and Y = car size): 4= Logistic Fit of size By age
1.0

* The bottom curve represents the predicted probability Boe PR ¢ _ O Large
that for a given age, someone will buy a large car. 075- -5'5-‘.'. ) - ) 0| — ' small % :;T
The second curve represents the probability that F
someone will buy a large or medium car.

The distance between the two curves represents the
probability that someone will buy a medium car. i
The distance between 1.00 and the top curve represents wEiH e 06| © -
the probability that someone will buy a small car. . TOS k'm;é.!' —— e
The cross-hairs show that the predicted probability that oA s W
someone aged 44.98 years will purchase a large caris 0.2373. d =

Medium

Notes: Simple nominal and ordinal logistic regression can also be performed from Analyze > Fit Model. For more
details see the book Basic Analysis (under Help > Books) or search for “simple logistic regression” in the IMP
Help.
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SIMPLE LOGISTIC REGRESSION

Lost Sales
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~  EXAMPLE: LOST SALES

“In many industries throughout the world, suppliers compete for business by
submitting quotes for work, services or products. A key criterion used to
determine the winning quote is the dollar amount of the quote, but other
factors include expected quality, estimated delivery time of the product,
or quoted completion time of the work.

The focus of this case is a supplier of equipment to the automotive industry.
The products of interest in this case are various precision metal
components used in a range of automotive applications, such as braking
systems, drive trains, and engines. Some of the products will be used in the
manufacture or assembly of new automobiles (i.e. original equipment),
while others will be used as replacement parts in automobiles already on
the road (i.e. aftfermarkert). tossaes smp case study Liorary | wwwwjmp.com/en us/academic/case-study-iibrary/muliple-regression.fm
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The data set contains 550 records for quotes provided over a six month
period. The variables in the data set are:

« Quote The quoted price, in dollars, for the order

e Time to Delivery The quoted number of calendar days within
which the order is to be delivered

e Part Type OE = original equipment; AM = aftermarket

o Status Whether the quote resulted in a subsequent

order within 30 days of receiving the quote:
Lost = the order was not placed,;
Won = the order was placed.

http://www.jmp.com/en_us/academic/case-study-library/multiple-regression.html
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Frequencies

Distributions
Quote

0 4000 8000 12000 16000 20000
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Level Count
Won 278

Lost 272

Total 550

N Missing 1
2 Levels

Time to Delivery

0 20 40 60 80100

Prob
0.50545
0.49455
1.00000




Contingency Analysis of Status By Part Type

Mosaic Plot
1.00
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Fit Group
Logistic Fit of Status By Quote

Status
O Won
+ Lost

80 100 120 140 160 180
Time to Delivery

0 2000 6000 10000 14000 18000 60
Quote

Parameter Estimates Parameter Estimates

Term Estimate Std Error ChiSquare Prob>ChiSq Term Estimate Std Error ChiSquare Prob>ChiSq

Intercept  0.0741106 0.1190632 0.39 0.5336 Intercept 0.58291532 0.1348966 18.67 <.0001*
Quote -1.8813e-5 0.0000299 0.40 0.5293 Time to Delivery -0.0181341 0.0034641 2740 <.0001*

For log odds of Won/Lost For log odds of Won/Lost
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|¥x Fit ¥ by X - Contextual - JMP Pro

[ _ N

Select Columns

¥4 Columns

ihstatus
r Quote
r

Part Type

Logistic
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Distribution of ¥ for each X. Modeling types determine analysis.

Cast Selected Co into Roles
¥, Resporfge | | Status

| X Factor | 4 Time to Delivery

Action
| OK |

| Cancel |

| Remove |
| Recall |
| Help |




Maodel DF ChiSquare/ Prob=Chisq
Difference 131 1 3226306
Full 365,066

Feduced g 22

R5quare [U)

AlCc

BIC

Cbservaticns (or Sum Wagts) 55

Measure Training Definition

Entropy RSquare 0.0423 (m
3 5 i 0 1 TL-LI0y™ (240
Mean -Log p

RMSE

Mean Abs Dev
Misclassification Rate
M
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Null hypothesis:

Probability of Won/Lost does not
depend on Time to Delivery

Alternate:
There is an association between
Won/Lost and Time to Delivery




Whole Model Test
Maodel -Loglikelihood
Difference 16.1 1

Full

Reduced

Entropy RSquare
Generalized RSguare
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http://www staftisticalhorizons.com/r2logistic

What's the Best R-Squared for Logistic Regression? | February 13, 2013 By Paul Allison



Whole Model Test

Maodel -Loglikelihood
Difference g

Full
Reduced

Model Fit

Misclassification Rate
M

http://www statisticalhorizons.com/r2logistic

What's the Best R-Squared for Logistic Regression? | February 13, 2013 By Paul Allison
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Wnle MdEITest

Model -Loglikelihood DF ChiSguare Prob=>ChiSq
Difference 16.13198 1 32.26396

Full 365.06624

Reduced 381.19822

R5guare () 0.0423

AlCe 734154

BIC 742752

Cbservations (or Sum Wats) 550

Measure Training Definition

Entropy R5quare 0.0423 1-Leglike(maodel)/Loglike(0)
Generalized R5guare 0.0760 (1-(LIOY)Limodel))™(2/n))/(1-LIO) 2/
Mean -l og 1 (L6638 3 -1 eqglalll/n

RMSE 0.4861 ¥ S(y[-p[l* n

Mean Abs Dey 0.4723 3 [y[l-oljl|/n Model Accuracy
Misclassification Rate 0.4001 E[;t[j]t—*pl"u-"lax}_-’n SN
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Parameter Estimates

Term Estimate 5td Error ChiSquare Prob>Chi5q
Intercept 0.58291532 0.1348966 18.67

Time to Delivery -0.0181341 0.0034641 2740

or log cdds of Won/Los

Log Odds SUCCGSS/FCI”UFG — this Value Ordering
ordering is dependent on the Specify data in the
response variable “value ordering” | the reports.

see Column > Column Properties > Won

Value Ordering Lost

Logistic Regression | Jim Grayson, PhD




Term Estimate 5td Error ChiSquare Prob>ChiSg
Intercept 0.58291532 0.1343%6 18.67

Time to Delivery -0.0181341 0.0034641 2740
For ||::E| odds of Wo r'|_-"L|:: EL

For logistic regression, the probability of an event, p, is
related to predictive factors, (X;.X,,....X,) by the
mathematical relationship where is called the

log(p/(1—p)) = Bo+ PoXi+...+ PiXk

Excerpt from Chapter 5: Logistic Regression from Building Better Models using JMP_(Draft) by Grayson, Gardner and Stephens (SAS Press).
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:z: Parameter Estimates
ol Term Estimate 5td Error ChiSquare Prob>ChiSg
Intercept 0.582091532 0.1348966 18.67
Tirne to Delivery  -0.0181341 0.0034641 2740
For log cdds of Won/Lost

The right side of this equation looks a lot like our multiple
linear regression model (without the error). Rearranging this
formula to solve for p directly, we have

p=1/(1+e Whir it

Excerpt from Chapter 5: Logistic Regression from Building Better Models using JMP_(Draft) by Grayson, Gardner and Stephens (SAS
Press).
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p(X)/[1-p(X)] is called the odds

Parameter Estimates

Unit
Term Estimate Std Error ChiSquare Prob>ChiSq Odds Ratio Odds Ratio
Intercept 0.58291532 0.1348966 18.67 <.0001*

Time to Delivery -0.0181341 0.0034641 2740 <.0001%.0.98202929 0.0362053/

For log odds of Won/Lost

Source: An Infroduction to Statistical Learning, James, et al (Springer), p. 132-3.
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4 = | oaistic Fit of Status Bv Time to Delivery
: Odds Ratios

Inverse Prediction +

v Logistic Plot - +
i Lost
Plot Options k 0%

+
ROC Curve

Lift Curve

I
Saves the probability formula into a

new column in the data table.
I ]

Save Probability Fn:urr‘mlg

ript

Most Likely
Lin[Won] Prob[Won] Prob[Lost] Status

0.2927690673 05726739109 04273260891 Won
-0.251255161 04375145854 05624854146 Lost
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Most Likely
Status

S Lin[Won] Prob[Won]  Prob[Lost]

1

0.58291532221625
+-0.0181341409344 * Time to Delivery

[1 + EHp[UﬂfWﬂﬂf”

Prob/Won] = "Won"
Match[Maximum[PmbfWonj. th{.f_osfi]] Prob[Lost] = "Lost”

1

E|SE = [E2)

[1 + Exp[— LinfWon] ]

p=1/(1+e WHITTRAY

Logistic Regression | Jim Grayson, PhD



Parameter Estimates

Term Estimate Std Error ChiSquare Prob>ChiSq
Intercept 0.58291532 0.1348966 18.67
Time to Delivery -0.0181341 0.0034641 2740

For log odds of Won/Lost

Assume fime to delivery = 90. From this logistic regression
model estimate the following four quantities using EXCEL:

Logit [same as Linear Model]
Odds [Exp(Linear Model)]
Probability of a Won [Odds/(1+Odds)]

Classification of Won/Lost [maximum probability]

Logistic Regression | Jim Grayson, PhD




Estimate Std Error ChiSquare Prob>ChiSq
B Intercept 0.58291532 0.1348966 18.67
Time to Delivery -0.0181341 0.0034641 2740

For log odds of Won/Lost

Assume time to delivery = 90.

Logit = intercept + time to delivery * value = 0.5829 - 0.018*%0

Exp (logit) = Exp(0.5829 - 0.018*90) = 0.3502
Odds/1+0dds = 0.3502 / 1 + 0.3502 = 0.2594

Prob Won =0.2594 then Prob Lost = 1-0.25%94
Therefore, status = LOST

Logistic Regression | Jim Grayson, PhD




A B C D E

4 Time to Delivery 90

6 Input variables Coefficient
. 7 Intercept 0.58291532

8 Time to Delivery -0.0181341

9

10

11 logit = =-1.0492 =E7+E8*C4

12

13 Odds = 0.3502 =EXP(C11)

15 p = 0.2594 =C13/(1+C13)

17 p = 0.2594 =1/(1+EXP(-(E7+E8*C4)))

Quote Part Type Validation Lin[Wamn] Prob[Waon] Prob[Lost] Status

Delivery

= -1.048157362 0.2593869435 0.7406150567 Lost

Logistic Regression | Jim Grayson, PhD



logistic regression model,
Increasing X by one unit changes the log odds by , (4.4), or equivalently if
multiplies the odds by eP

The amount that p(X)
changes due to a one-unit change in X will depend on the current value of X
B, is positive then increasing X will be
associated with increasing p(X) B, is negative then increasing X will be
associated with decreasing p(X)

Source: An Introduction to Statistical Learning, James, et al (Springer), p. 132-3.
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VISUALIZING LOGISTIC MODEL FIT

For a Time to Delivery of 90
days,

there is about a 25% chance
of “Won" and a 75% chance
of “Lost”

* To color points and add a legend, right-click in the graph and
select Row Legend. Select a variable under Mark by Column,

and select Markers to change the marker, and click OK.

B Mark by Column

~' 8 Columns Colors: | JMP Vibrant ~ | - Row States
il Continuous Scale Status
4 Quote Reverse Scale O Won
4l Time to Delivery + Lost

60 80 100 120 140 160 180 i Part Type Markers: | Standard -

. . il Validation
Time to Delivery dLin[Won
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MULTIPLE LOGISTIC REGRESSION
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Multiple Logistic Regression
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Multiple Logistic Regression

Multiple logistic regression is used to predict the probability of the occurrence of an event using more than one

—e—— """ | explanatory variable.
Multiple Logistic Regression Using Fit Model Example: Car Pl jmp {Help > Sample Data)
= R Model - P
- 1= Model Specification
From an open JMP data table, select Analyze > Fit Salact Columns Pick: Aok Variabkes Persenaity: [Hominal Logistic
5o L e
Model. hmorital shahs = ..
Click on a cartegoTesrerhrs grrSelect Columns, and ::li::....,,- — Help R
= Facal =
click Y (nominal variables have red bars, ordinal variables :m_”: Freq F— e ke e
have green bars). i
3. Choose explanatory variables from Select Columns, and Cortnact Model Eects
click Add. L rrarital stz
Lross e
4. Click Run Model. . =
sl
By default, IMP will provide the following results: Mg =
Deree [ 2]
*  The Iterations history (not shown). Airbafes =
Transfarm =
The Whole Model Test. Mo rercept
Lack of Fit (not shown). .
Tips:

Parameter Estimates for the model.

Effect Likelihood Ratio Tests (not sh ) * When the response is ordinal, an ordinal logistic model will
=] IKelinoo atio 1asts (notT shown).
be fit. When the response is nominal, as in this example, a

nominal logistic model will be fit.

* To save the predicted probabilities to the data table, click

on the top red triangle, select Save Probability Formula.

Logistic Regression | Jim Grayson, PhD
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Multiple Logistic Regression

Multiple logistic regression is used to predict the probability of the occurrence of an event using more than one

explanatory variable.

' Whole Model Test

Maodal -LagLikelihood DF ChiSguare Prob=ChiSg
Ditterence 22.99752 B 4599504

Full 28019796

Reduced 303.19548

RSquare (L) 0.0754
Al c 2/0.88G
Bl &U6. 1046
iDosarvations (or Sum Wgts) 303

Measure Training Definition

Entropy RSqueare 00759 1-Loglke{model)/Loghke(d)
aeneralized REquars 01628 (1-(L{OWLImodeli}* (2] 1-LI3*(2/n))
lean -Log p 09247 ¥ -Loglp[j]l/n

RASE 05827  Yivii-ell)/n

hMean Abs Dev 0.5462 F |vlil-plill/n

Misclassification Rate 04290 F (p[j] #pMax)/n

M 303
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Multiple Logistic Regression

Multiple logistic regression is used to predict the probability of the occurrence of an event using more than one

explanatory variable.

Parameter Estimates

Term Estimate Std Error ChiSquare Prob>Chisq
Intercept 021751807 QRAZR0E QD6 O.B0TE
sex|Female] 010271474 01674203 038 0.5395
marital status[Married] 0.23532617 (1813837 169 0.1939
age 002719008 00281513 083 03341
Intercept 3, 0890496] 10026577 =

sex|Female| 00515722 01822018 QLB

marital status[Married] -0.3754868 0 1868537 4.04

age 0.0779815 00329797 559

Faor log odds of FamilyM\Work, Sporty/Waork

Logistic Regression | Jim Grayson, PhD
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Multiple Logistic Regression

Multiple logistic regression is used to predict the probability of the occurrence of an event using more than one
explanatory variable.

To view the effect of an explanatory variable on the
predicted probabilities, click on the top red triangle and

select Profiler. T—

In the Prediction Profiler, click and drag the vertical red line

for a variable to change the level or value. The predicted
probabilities are displayed.

4 =/ Prediction Profiler

Married

Note: For more details on logistic regression, see the book Fitting Linear Models (under Help > Books) or search
for “multiple logistic regression” in the IMP Help.

Logistic Regression | Jim Grayson, PhD




= Fit Model - JMP Pro

Lost Sales: Multiple Regression Model

4 = Model Specification
Select Columns
* 4 Columns
thStatus
ﬁﬂ_uc:e
4lTime to Delivery

WhPart Type

Logistic Regression | Jim Grayson, PhD

Pick Raole Variables
| ¥ | ik Status

| Weight |
| Freq |

| Validation |
| By |

Construct Model Effects
| Add | Quote
—————— | Time to Delivery

Cross Part Type

|
| Mest |
|

Macros = |

Personality: | Mominal Legistic

| Help | | Run

| Reall | Keep dialog open

| Remove |







Whole Model Test

Model -Loglikelihood DF ChiSquare Prob>ChiSq
Difference 19.28543 3 38.57086 <.0001*
Full 361.91279
Reduced 381.19822 i ifi ? .

Model Slgmflcant' Parameter Estimates
iISgcuarE(U} ?gfggg Term Estimate Std Error ChiSquare Prob>ChiSq
BIC ?492065 |\/|ode| flt,) Intercept 0.54119866 0.1667172 10.54 0.0012*
Observations (or Sum Wqts) 550 - Quote -0.0000193 3.0733e-5 0.39 0.5299
Measure Training Definition Time to Delivery -0.0183689  0.003483 2781 <.0001*
EfiHicpy RSquare 30505 T-Loglike(midell/Laglike(d) Part Type[AM]  0.23555514 0.0983823 5.73 0.0167*
Generalized RSquare 0.0903 (1-(L(0)/L(model))*(2/n))/(1-L(0)*(2/n))
Mean -Log p 0.6580 I -Log(p(jl)/n For log odds of Won/Lost
RMSE 0.4832 V S(y[jl-pliD*/n
Mean Abs Dev 0.4667 3 ly(jl-pll/n
Misclassification Rate 0.4018 % (p[jl#pMax)/n
N 550 n

Effect Likelihood Ratio Tests

L-R
Source Nparm DF ChiSquare Prob>ChiSq
Quote 1 1 0.39541571 0.5295

Time to Delivery 1 1 32.790892 <.0001*
Part Type 1 1 5.78404388 0.0162*
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- Whole Model Test
Model -LoglLikelihood DF ChiSquare] Prob>ChiSq We look at p-VC”U@ for overall

Difference 19.28543 3 38.57086) . .pe
Full R L i model significance.

Reduced 381.19822

RSquare (U) oo We look at R§quore for a
AlCc 731.899 measure of fit

BIC 749.065
Observations (or Sum Wgts) 550

Measure ini efinition We |OO|< CIT RMSE Oﬂd
Entropy RSquare 0.0506 [L-Loglike(model)/Loglike(0)
Generalized RSquare iu:!':;'!ﬁ:n:F(L(O)/L(model))'\(2/n))/(1L(O)*“(2/n)) MeCIn Abs DeV for a

Mean -Log p 065805 -Log(p[jl)/n measure of error.
RMSE 0.4832 N S(yljl-elj))¥/n

Mean Abs Dev 0.4667 I |ylil-pljll/n . e .
Misclassification Rate | 0.4018 [ (p[jl#pMax)/n We look at misclassification

N 550 rate for a measure of
predictive abillity

Logistic Regression | Jim Grayson, PhD




e interpret coefficients for logistic
regression differently than linear
regression coefficients.* Increasing an X
by one unit changes the log odds by b,
or it multiplies the odds by e P! but the
rate of change depends on the current

value of X.

*Chapter 4: Classification, An Introduction to Statistical Learning by James, et al (Springer)
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Lost Sales

Parameter Estirf

Term
Intercept
Quote
Time to Delivery\ -0.0183689
Part Type[AM] 0.2355551¢
For log cdds of WohlLost

Estimate
0.54119866

Unit Odds Ratios

Per unit change in regressor
Term Odds Ratio

Quote 0.999981
Time to Delivery ~ 0.981799

5td Error
01667172

o me e O =
-.\_II._I.\_I.\_I.\_Ilgj -

0.003483
0.0983823

Lower 95%
0.99992
0.974896

ChiSquare Prob>Chi5g
10.54

0.39

2781

3.73

0.5299

o
IR ERY,
U L

Upper95% Reciprocal
1.000041 1.0000193
0988314 1.0185386




A - Nominal Laaistic Fit for S I—

v Likelihood Ratio Tests
I Wald Tests
Confidence Intervals
v Odds Ratios

Inverse Prediction...

Confusion Matrix

Save Probability Formula
ROC Curve

v Confusion Matrix

v  Profiler

Actual Predicted
Training Won Lost

Won 193 85

Lost 136 136

Model Dialog
Script
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ification Rate 0.4018

Confusion Matrix

Training

Actual Predicted
Status Won Lost

Won
Lost

Logistic Regression | Jim Grayson, PhD

We look at the confusion matrix

For example, our model
predicted a Lost 85 times [or
85/(193+85) = 30 percent] when
in reality it was a Win.

Similarly, our model predicted a
Win 136 times when the reality
was a Lost, or 50% of the cases.
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INTERPRET RESULTS (APPLICATION)




A« Mominal Lonistic Fit for S _

Most Likely
Lin[Won] Prob[Won] Prob[Lost] Status
v Likelihood Ratio Tests
WadTete  me 0.7094655787 06702830015 03297169385 Won
d EELE
00099710991 05024927541 04975072458 Won

= Confidence Intervals
v Odds Ratios

Inverse Prediction...

Save Probability Formula
ROC Curve

1 1

Lift Curve

1+ Exp[— LinfWon] ] 1+ Exp[.f_fﬂchrﬂj'”

v Confusion Matrix
v  Profiler

Model Dialog 0.54119865783093
_ [+-0.0000193051213 * Quote

+-0.0183688946473 * Tume to Delivery

Script

Prob{Won] = "Won"
Prob{lost] = "Lost"

"AM" = 0.23555513631527
+ Match[Pm‘t Type] "OE" = -0.2355551363133

EIS_E :::_ (2N 2]

glse =,
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HOW TO UNDERSTAND THE MANAGERIAL
IMPLICATIONS




= ~|Nominal Loaistic Fit for S

v Likelihood Ratio Tests
Wald Tests

Confidence Intervals

Odds Ratios

Inverse Prediction... R

A= R
31.79

ROC Curve Time to
Lift Curve Delivery

Save Probability Formula

Confusion Matrix

Profiler > ~/Variable Importance: Independent Uniform Inputs

Model Dialog 4 Summary Report

Column Main Effect Total Effect .2 4 .6 B
Time to Delivery 0.919 0.93 |
Part Type 0.06 oos4l] @ o ¢
Quote 0.018 0.018]

Seript
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HOW TO APPLY THE RESULTS




. N

61

USING PROFILER TO PREDICT

What is the estimated probability of a Win for a proposal of:

Quote = 5000
Time to Delivery = 60
Part Type = AM

*/Prediction Profiler

Logistic Regression | Jim Grayson, PhD




LOGISTIC REGRESSION PREDICTIVE
MODELING




_—ff

Developing a validation varible and then using the “validation™
portion to evaluate predictive ability of the model.

Time to
Delivery Part Type Validation

OE Validation
AM Training
OE Validation
OE Validation
AM Training

AKA L I e

—

s

| Model Specification
Select Columns Pick Role Yariables Persnnalit}f:mnminal Logistic
!5 Columns [ ¥ | |tk Status

thStatus
Ajuocte | Help | | Run |
AMTime to Delivery | Weight |
WhPart Type —
thValidation | Freq | | Remove |

C\fandatiuﬂ ‘Jali@

| By |

| Recall | Keep dialog open

Construct Model Effects

| Add || Quote
Tirne to Delivery
Part Type
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* Mominal Loaistic Fit for S pres

Likelihood Ratio Tests

Wald Tests Measure Training | Validation| Definition
Entropy RSquare 0.0748 -0.006|1-Loglike(model)/Loglike(D)
(Generalized R5quare 0.1312 -0.011 | 2-(LD) Limodel})*(2/n)) 1 -L{0) " (2/n])
Mean -Log p 0.6399 0.6959|% -Logip[j])/n
Inverse Prediction... RMSE 0.4741 05012+ El:}f[j]-r_'l'[j]:lz.-'rr'l
Save Probability Formula Mean Abs Dev 0.4495 047301 % |v[jI-elj]})/n
ROC Curve Misclassification Rate  0.3758 0.4636| % (p[jlzpMax)/n
M 330 220 n

Confidence Intervals

Cidds Ratios

Lift Curve

Confusion Matrix

Profiler

Confusion Matrix

Actual Predicted | Actual Predicted
Training Won Lost Validation Won Lost
Won 125 49 Won 65 39
Lost 75 81 Lost 63 53
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— *Nominal Loaistic Fit for S

v Likelihood Ratio Tests —  — 65

Wald Test m— > r : 2 o T
TR Receiver Operating Characteristic Receiver Operating Characteristic or| Validation Data

1.00 ——= 1.00

| Confidence Intervals

= v Odds Ratios

0.90

Inverse Prediction...

The ROC curve is meosurihg fhe
ability of the predicted

v ROC Curve L e
] |1 e probability formula to rank an oo
v Confusion Matrix . i
| Proiter observation.

Sensitivity
(=]
(9]
o

Vertical segment means 0.30
predicting “success” [Won] 020
and horizontal segment means o[
o A kit = LR ] !_/
predicting “failure” [Lost] 0.00

o e e el Ll il il el e 0.00 0.10 0.20 0.30 0.40 0.50 0.60 0.70 0.80 0.90 1.00
1-Specificity 1-Specificity

Status Area Status Area
= Lost 0.6784 = Lost 0.5739
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Constructing an ROC Curve

Here is a practical algorithm to quickly draw an ROC curve after the table has been
sorted by the predicted probability. We walk through the algorithm for Offer
Accepted=Yes, but this is done automatically in JMP for each response category.

For each observation in the sorted table, starting at the observation with the highest
probability Offer Accepted = Yes:

* If the observed response value is Yes, then a vertical line segment (increasing,
along the Sensitivity axis) is drawn. The length of the line segment is 1/(total
number of Yes responses in the table)

If the observed response value is No, then a horizontal line segment (increasing, along the 1-
Specificity axis) is drawn. The length of the line segment is 1/(total number of “No” responses in
the data table)

DRAFT, Building Better Models Using JMP Pro by Grayson, Gardiner and Stephens (SAS)
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— Figure 6.30: Credit, ROC Curve for Offer Accepted

v Receiver Operating Characteristic » Receiver Operating Characteristic on Validation Data
1.00 1.00

0.90 0.90
0.80 0.80
0.70 ! 0.70
0.60 0.60
0.50 £ 0.0

0.40
0.30 0.30
0.20 0.20
0.10 0.10
0.00 0.00

000 020030 050 070 0.0 0.00 020030 050 070
1-Specificity 1-Spacificity

Offer Offer

Accepted Area Accepted Area
- Yas 0.7539 — ¥es 0.7369
— Mo 0.7539 — Mo 0.7369

DRAFT, Building Better Models Using JMP Pro by Grayson, Gardiner and Stephens (SAS)
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Simple ROC Curve Examples

We use a simple example to illustrate. Suppose we have a data table with only 8
observations. We sort these observations from high to low based on the probability that
the Outcome=Yes. The sorted actual response values are Yes, Yes, Yes, No, Yes, Yes, No,
and Yes. This results in the ROC curve on the left of Figure 6.31 (arrows are added to
show the steps in the ROC curve construction). The first 3 line segments are drawn up
because the first three sorted values have Outcome=Yes.

Now, suppose we have different probability model that we use to rank the observations,
resulting in the sorted outcomes Yes, No, Yes, No, No, Yes, No, and Yes. The ROC curve
for this situation is shown on the right of Figure 6.31. The first ROC curve moves “up”
faster than the second curve. This is an indication that the first model is doing a better job
as separating the Yes responses from the No responses, based on the predicted

probability.

DRAFT, Building Better Models Using JMP Pro by Grayson, Gardiner and Stephens (SAS)
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ROC Curve Examples

DRAFT, Building Better Models Using JMP Pro by Grayson, Gardiner and Stephens (SAS)
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i S

Referring back to the example ROC curve in Figure 6.30, we see that JMP Pro has also
8 displayed a diagonal reference line on the chart, which represents the Sensitivity = I-
------------ Spectficity line. If a probability model cannot sort the data into the correct response
category, then it may be no better than just sorting at random. In this case, the ROC curve
for a “random ranking” model would be similar to this diagonal line. A model that sorts
the data perfectly, with all the Yes responses at the top of the sorted table, would have an
ROC Curve that goes from the origin of the graph straight up to sensitivity = 1, then
straight over to 1-specificity = 1. A model that sorts perfectly can be made into a classifier
rule that classifies perfectly - that is, a classifier rule that has a sensitivity of 1.0 and 1-

specificity of 0.0.

The area under the curve, or AUC (labeled Area in Figure 6.30) is a measure of how good
our model does at sorting the data. The diagonal line, which would represent a random
sorting model, has an AUC of 0.5. A perfect sorting model has an AUC of 1.0. The area

under the curve for Offer Accepted = Yes is 0.7369 (see Figure 6.30), indicating that the
model predicts better than the random sorting model.

DRAFT, Building Better Models Using JMP Pro by Grayson, Gardiner and Stephens (SAS)
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* Mominal Loaistic Fit for

v Likelihood Ratio Tests
Wald Tests

Lift Curve ¢n Validation Data

v Confidence Intervals

v  Odds Ratios
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Inverse Prediction... 1.7
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Another measure of how well a model can sort outcomes is the model lift. As with the

ROC curve, we examine the table that is sorted in descending order of the predicted
probability. For each sorted row, we calculate the sensitivity, and we divide that by the
proportion of values in the table where Outcome=Yes. This value is the model lift.

Lift 1s a measure of how much “richness” in the response we achieve by applying a
classification rule to the data. A Lift Curve plots the Lift (on the y-axis) against the
Portion (on the x-axis). Again, if we consider the data table that has been sorted by the
predicted probability of a given outcome, as we go down the table from the top to the
bottom, the portion is just the relative position of the row we are considering. The top
10% of the rows in the sorted table corresponds to a portion of 0.1, the top 20% of the
rows corresponds to a portion of 0.2, and so on. The lift for Qutcome=Yes, for a given
portion, is simply the proportion of Yes responses in this portion, divided by overall
proportion of Yes responses in the entire data table.

DRAFT, Building Better Models Using JMP Pro by Grayson, Gardiner and Stephens (SAS)
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STEPWISE




4= Model Specification

Select Columns Pick Role Wanables

Personalfty: | Stepwise .2
> 9 Columns | v |[{whStatus
ihStatus -
: ﬁQuntE | Help | | Run
- Time to Delivery - —
Weight
iPart Type |L—g| |ﬂ| Keep dialeg open
;!:‘lif_ali[fftia]n | Freq | [ Remove |
in[Won S— — I
Validat Validat
Prob for Status (2/0] |ﬂ| e
IIIMDEt Likely Status | B'_‘," | THCTCIT T IO O T T OO, Coe LT aT e, Eo L,

ﬂ — - -
Construct Model Effects StEPWISE Fit for Status

| Add || TimetoDelivery || < Stepwise Re
———————— Part Type
L Cross  ||quote Stopping

le: | Max Validation RSquare + |:| | Enter All | | Make M-:u:lell

|F|:|rwar|:| ‘fl

| Whole Effects « |

Directions |;| |Rernove All| | Run Model |

Rules:

| Go || Stop

RSquare Avg Log Error
-Loglikelihood p RSquare  AlCc BIC Validation Validation
22824742 4 -0.000 458507 462.294 -0.009 0.697615
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4 = Stepwise Fit for Status

4 Stepwise Regression Control

Stopping Rule: | Max Validation RSquare ~ |

Direction: |Forward |
Rules: | Whole Effects 'l
| Go || Stop || Step |

-Loglikelihood
215.3768

p RSgquare AlCc
2 00564 43479 442352

< Current Estimates
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BIC Validation

Lock Entered Parameter Estimate nDF Chi5q "Sig Prob"
Intercept[Lost] 0.79032576 1 0 1

v Time to Delivery  -0.0222267 1 221115 2.57e-b

Part Type{ AM-OE} 0 1 8.185467 0.00422

Quote 0 1 0.006437 0.93605

(mp || Enter All | [Make Modell

|:| |Fler'r1|:|*.rEAII| | Run Model |

RSquare Avg Log Error
Validation

0.0086 0685670

Wald/Score
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